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Quick Start

. NMecS
MecSoft Corporation Qe 0

Your CAM Partner

MILL Module 2026

Prefer Printed Documentation? Click Here!

What's New | Quick Start Play List

Quick Start Guides for each Visual CAD/CAM module are available in both PDF and Video format.
Refer to the following information to access these resources:

1] How to Access the Quick Start Guide Documents

To help you quickly get started in working with each module, select one of the Help
buttons located on the Visual CAD/CAM Learning Resources dialog.

You will find:

e Quick Start Guides

e What's New documents
e Online Help links

The Quick Start Guides will help you step through an example tutorial which will
illustrate how to use the module. To access the Learning Resources dialog:

1. From the VisualCAD Home Ribbon Bar, drop down the Main menu and select Learn ...

© Mec Soft Corporation


https://mecsoftcorp.github.io/VisualCADCAM-2026/Resources/VisualCADCAM2026-Resource-Guide.pdf
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https://www.youtube.com/playlist?list=PLx9G05pFm0QISEAjFqPkrNRyUTOYw9ZRZ
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To access the Learning Resources dilog in VisualCAM

ﬂ Web-site

& Help ...
0d About ..

2. Select a document from the Learning Resources dialog to get started using the

module of your choice.

¥ You can also select the Open Quick Start Files Folder button located at the bottom
of the dialog to open the Quick Start folder where the source files (start and
completed versions) are located.
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Learning Resources X

Welcome to VisualCAM 2026!

Toget started as quickly as possible use the following resources.

MILL TURM
2 @ WU e LU
What's New? Web Resources On-Line Help Quick Start On-Line Help Quick Start
Profile-MEST —————————  G-Code Editor
@ U e W
On-Line Help Quick Start On-Line Help Quick Start
MEST ART
@ U e W
On-Line Help Quick Start On-Line Help Quick Start

Where to go for more help:
Togetyourspecific support questions answered clidk here to fill out a support form.

Forall otherinformation visit ourweb-site www.mecsoftcom

Open Quick Start Files Folder

Learning Resources Dialog
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Resource Guide

Download this PDF Guide for a list of the available Visual CAD/CAM Resources.

[T] 2026 VisualCAD/CAM Resource Guide

. SO aw The 2026 VisualCAD/CAM Resource Guide!
VisualCADCAM

) 18 Pages
Resource Guide

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Prefer Printed Documentation? Click Here!

What's New | Quick Start Play List
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About this Guide

. NJecS
MecSoft Corporation IEL{;

Your CAM Partner

MILL Module 2026

Prefer Printed Documentation? Click Here!

What's New | Quick Start Play List
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3.1 Useful Tips

Here are some useful tips that will help you use this guide effectively.

1. Copy the tutorial files to a location other than the installation folder to make sure you
have read/write privileges to the files.

2. Once you start working with the tutorial file, save your work periodically!

3. Don’tstress out too much if you are having trouble with the tutorial. Call us or send us
email and we can help you out.

4, Most of all have fun!
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https://mecsoftcorp.github.io/VisualCADCAM-2025/Resources/VisualCADCAM2025-Resource-Guide.pdf
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3.2

3.3

About the MILL Module

The VisualCAD/CAM module offers fast gouge free solids/surface model machining technology
coupled with cutting simulation/verification capabilities running inside Visual CAD for
programming CNC Mills. This integration allows for seamless generation of toolpath and cut
material simulation/verification within VisualCAD, for programming milling machines that
support 3, 4and 5 axis continuous machining.

The module also comes with numerous post-processors to output the programmed G-code to
some of the most popular machines on the market. A simple and well thought out user interface
makes this system one of the most intuitive and easy to use milling systems available today.

You can work with the native VisualCAD data as well as use any of the data types that can be
imported into Visual CAD such as solids, surfaces and meshes. Then you can use the

Visual CAD/CAM module with its wide selection of tools and toolpath strategies to create
machining operations and associated toolpaths for CNC Mills. These toolpaths can then be
simulated and verified, and finally post-processed to the controller of your choice.

Using this Guide

If you have installed Visual CADCAM successfully on your computer and are now looking at the
blank screen of VisualCAD and wondering what to do next, this is the guide for you. This guide
will explain how to get started in using the Visual CAD/CAM module to program a simple part
through an example.

This guide will illustrate machining of a simple prismatic part such as this gasket using 2-1/2 Axis
milling operations. Even though we have created a 3D representation of the gasket, it will become
apparent as we go that we can machine this using just 2D curves. The reason we are able to do
this is because of the prismatic nature of this model, which means that the curves can be treated
as the edges of vertical walls in the geometry.

This guide has two associated VisualCAD files that you can find located in the QuickStart folder
under the installation folder of Visual CAD/CAM. The first file is a completed file that contains all
of the completed toolpaths and machining operations and represents the file that you should end
up with after working through the tutorial. The other file is a starter file that contains only the
geometry. Use the completed file as a reference. Copy the starter file and use this file to begin
the tutorial.
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MILLQuickStartTutorial.vcp

3.4 Watch the Video

Want to see a video demonstration of this quick start guide? Just click on the play list below and
watch the MILL Quick Start Guide video.

[:[:] What's New!
What's New in Visual CAD/CAM 2026

1] The Complete Quick Start Video Play List

Here is a link to the complete 2026 Video Play List

© Mec Soft Corporation


https://www.youtube.com/playlist?list=PLx9G05pFm0QKmM1LY2ydDA_vro-WPOo4E
https://www.youtube.com/watch?v=DhaKXniztt4&list=PLx9G05pFm0QKmM1LY2ydDA_vro-WPOo4E
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Getting Ready

41 Running VisualCAD/CAM

Locate the VisualCAD/CAM 2023 shortcut on your desktop and double click to launch the
application.

Alternatively you can also click on the Windows Start button and select All Programs. Go to the
program group containing Visual CAD/CAM 2026. (The name of this program group will usually be
called VisualCAD/CAM 2026, unless you specified otherwise during setup.)

Once you locate the program group, select it and then select Visual CAD/CAM 2026 to launch the
application.

If the installation was successful, upon launching of Visual CAD/CAM 2026 you should observe a
menu entry called Visual CAM 2026 on the Home Ribbon Bar menu of Visual CAD.

If you do not see this menu entry then please check the On Line Help document of the product
(found in the installation folder) for help with trouble shooting the installation.

4.2 About the VisualCAM Display

Before we begin, let's talk a bit about the VisualCAD display. When you run VisualCAD for the
very first time, your screen may look this.
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These windows on the left belong to plug-in modules that are currently loaded. For now, let's
close all of them.
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4.3 Load the MILL Module

Now, let's begin by launching the Visual CAD/CAM module.

1. From the Plugins pane of VisualCAD's Home Ribbon Bar, you will see the VisualCAM 2026
main menu item.

2. Drop-down the menu and pick MILL to load the module.

© MecSoft Corporation
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3. Docked on the left you will see the Machining Browser and the Machining Objects
Browser. When you first run Visual CAD/CAM, these two browsers my be docked side by
side. However, you can move them anywhere on the screen that feels comfortable for

you.
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4. Forexample, let's move the Machining Objects Browser so that it displays under the
Machining Browser on the left. Simply left-click and hold the title bar of the browser and
dragit around on your screen.
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While doing so, you will see the docking widget display in the background with directional
buttons allowing you to choose screen locations relative to the active window.

5. We'll drag the Machining Objects Browser over the base of the Machining Browser until
the cursor activates the bottom directional button.

When the preview of the new location displays, let go of the right-mouse button and the
browser will move to that location.
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6. You can also re-size the height and width of each browser making sure that all of the

4.4

command icons and menus are easily accessible.
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Load the Part Model

“Part” refers to the geometry that represents the final manufactured product. You can create parts

within VisualCAD or import geometry created in another CAD system.

1.

From VisualCAD's Main Menu, select Open.

“’i._a | N Gl A DD
.. Click here for

j Main Menu nts
New

ﬁ' Open .. I}

'ﬁe ctangularMESTQuickStartTutorial.vep

2 ARTQuickStartTutorial_Completed.vep

Open (Ctrl+0) i
E:. Browse .. pe pleted.vcp
" Open an existing document
il - pleted.vcp
Import ... ) .
™ 5 MILLOuickStartTutorial_Completed.vep

i i P e P N
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2. Fromthe Open dialog box, select the MILLQuickStartTutorial.vcp file from the C:
\ProgramData\MecSoft Corporation\VisualCAM 2026\QuickStart\ folder. As mentioned
before, itis advisable to make a copy of this part at a suitable alternative folder so that
you have write privileges to modify the part.

B By default, the ProgramData folderis "hidden" from view. Here are the steps
to Show hidden files and folders:

1. For Windows 8 users: Go to Control Panel > Appearance and Personalization >

Folder Options.
For Windows10 users: Go to Control Panel > Appearance and Personalization >

File Explorer Options.

2. Select View tab and under advanced settings select Show Hidden files and
folders, clear the check boxes for:

e Hide extensions for known file types

e Hide protected operating system files (Recommended)

Advanced settings:

Always show menus -
Display file icon on thumbnails
Display file size information in folder tips
Display simple folder view in Mavigation pane
[ Display the full path in the title bar (Classic folders only)
Hidden files and folders
(7) Do naot show hidden files and folders
(@ Show hidden files and folders
[ Hide extensions for known file types
B
[] Launch folder windows in a separate process
Remember each folder's view settings w7

-

3. Click Apply and OK.

The part appears as shown below

© Mec Soft Corporation
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MILLQuickStartTutorial.vcp

n You can import solid models, Stereo-Lithography (both ASCII and binary)
format files. Surfaces and Solids can be imported from IGES, STEP, Rhino
(*.3dm), Parasolids (*.x_t, *.X_b), SAT and DXF / DWG files. Faceted (triangulated)

models can be imported from STL, VRML, Raw Triangle, or Rhino Mesh.

3. Fromthe View toolbar, select the Isometric View to work in.

4.5 Machining Strategy

Based on the type of geometry of this part, we will machine this model out of a10x 6x 1/8 inch
poplar wood sheet. Since the part is relatively thin and prismatic, we will machine this out by
using only a single type of machining operation - 2-% axis machining method called Profiling. We
will also use just a single 0.5 inch flat end mill for performing all machining. We will also assume
that the wooden sheet will be held to the machine table or the spoil sheet on the table using
double-sided tape or a vacuum table requiring no clamps or fixtures.

4.6 Main Programming Steps

The following steps will be followed in machining this model. Some of these steps will have to be
performed just once and others may have to be repeated to complete the machining.

1. Define the Machine and Post-processor to use.
2. Define the Machining Setup including Stock Geometry, Material and Work Zero.

3. Create and Select a Tool to use for machining.

© Mec Soft Corporation
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4. Create the Machining Operations including the Feeds and Speeds, the Clearance Plane

and other Cutting Parameters.
5. Generate the toolpaths.
6. Simulate the toolpaths.
7. Post Process the toolpaths.
8

Generate Shop Documentation.

4.7 Define the Machine Tool

Let's start by defining the Machine to use for this job.
1. From the Program tab select Machine to display the dialog box.

miLL | f3 Program Simulate o &0

¥ Machine 6]3 Stock = o™ Work Zero Zi 4 Axis - &
& Post [ B nign - 2 2Axis v (B SAxis T g v
©7 Setup v ¥E Material  af 3 AxisAdv - gy Holes ~

Machine Setup Stock Machining Operations

Machine

'H Machine Tool Setup

g Fixtures - Mone

g Setup 1

2. Under Machine Type, set the Number of Axes to 3 Axis.

Machine Tool Setup @
Machine Tool Definttion |
@ Manual Definition (") Load From File
tachine Type
MNumber of Axes
" eneral Feramg ers L

3. Pick OK and notice that the Machine type now appears under Machining Job in the
Machining Browser.
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=1, Machining Job

iz Post- Ahintﬁims

fiﬂ Stock - Mone

@ Fixtures - Mone
g Setup 1

4.8 Select the Post Processor

Next, we'll define the Post Processor.

1. From the Program tab select Post to display the dialog.

MlLLII‘m Program Simulate o H -8 @
M Machine @ Stock - “ Work Zero 2= 4 Axis ~ &
5 Post B nign v 2 2mxis v (@ 5Axis v g -
7% Sewp v §E Material A 3 AxisAdv v gy Holes -
Machine Setup Stock Machining Operations

Post

£ Set Post-Processor Options

L--_H STOCE = TIOTE

@ Fixctures - Mone

i‘g Setup 1

2. Forthe Current Post Processor, select Haas from the list of available posts.

3. Then set the Posted File Extension to .nc. Other file extensions are available depending
on your machine requirements.

© Mec Soft Corporation



Select Post-Processor

Select Post-Processar

Poszt-Proceszor type

(®) Use Legacy Post () Use Programmable Post

Select Post Processar

Current Post Processor | Haas we | Edit ...

Folder where post-proceszor files are located:
C:AProgramD atathecSoft Corporation’,

Cancel Help

[ By default, post processor files are located under

C:\ProgramData\MecSoft Corporation\VisualCAM
2023\Posts\MILL\SPM\

The program to send the posted output data to is set to notepad.

Getting Ready 21

4. Pick OK and notice that the Post type now appears under Machining Job in the Machining

Browser.

=] Machining Job
y Machine - 3 fxis

=
f“-ﬂ StockaMone

@ Fixtures - Mone

tqf Setup 1

5. Now let's have alook at the Post related Preferences. Pick the CAM Preferences icon at
the top left of the Program tab and then select the Post-Processor tab as shown below.
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MILl|'H Program Simulate & g 'r@‘g
M Machine f'_i Stock * o WorkZero O 4 Auis -
& Post B aign - 2 aaxis - G S -
Setup = | = Materisl AL 3 Axis Adv ~ iy Holes -
Machine Setup Stock Machining Operations

3 Machine - 3 Axis
f% Post- Haas

£ Stock- None
Fixtures - None

& Setup 1

B PaR

Gmomety
Festures
Stock:

Cutting Tools

Feeds & Speeds

M ascihinirsg
Oukput Cortrcl
Toolpath
Sirndsticn
Ugr Irgartace
Pzt Processor
Licenzing

Progeam to send posted fle to
rotepad

Pasted Fie Maming Corventions
‘When 8 Machinng Operstion(s] i seleched for Posting, use
Pragt Fili: H.am+M achining Operation M ams

when a Setup iz selected lor Pasting, wie
Pt File: Hlame+ 5 etup Mame

When posting allin file, use

Prast Fili: Hlame

Fasted Fila Extension | - Add Mew .
[T File Extension from Post Processor:

[ Shows Dutput Dishog when Past-Processing

For Post File Extension select .nc from the dropdown list. If you need a different
extension, pick the Add New button and enter your file extension and pick OK. The

posted file extension looks like this: my-gcode-file.nc
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The Setup

5.1

5.2

Machining Setup - Skip if in STD or EXP Configuration

Now let's define the Machining Setup. The Machining Setup allows you to orient the Machine
Coordinate System such that the partis aligned in exactly same way as it would be fixtured on the
machine tool for cutting.

@ This functionality is available only in the Professional and
Premium configurations of the product. When working with
your part files and running the Express, Standard or Expert
configuration, you will have to use the CAD tools to orient the part
geometry so thatitis in the correct orientation for machining.

If in the future, if there is no Setupl listed under your Machining Job, the system automatically
creates one when a Work Zero or an operation is generated.

However in our tutorial part, by default, the MCS (Machine Coordinate System) is already aligned
with the WCS (World Coordinate System) so this step is not required for this part.

However, in production you can have multiple setups and assign different machining orientations
for each, when running the Professional or Premium configurations.

Create Stock Geometry

In this step we'll define the raw stock from which to cut the part.

1. From the Program tab select Stock and then select Box Stock from the menu to display the
dialog.
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MlLLII‘m Program Simulate o H -8 @
M Machine 6]3 Stock |~ “ Work Zero 2= 4 Axis ~ &
£ st S
iz Post Box Stock w5 Axis T R -
is: Setup T F I'i'l Holes ~
] Part Box Stock ]

Machine Setup ng Operations
= [IL Machin Cylinder Stock

J«f’ M Part Cylinder Stock

] pc

9 st Part Offset

@ Fix

Extruded Stock

Str m = lectinn

2. Under Dimensions, set the Length Lto 10.0, Width W to 6.0 and Height H to 0.125.
Note that the stock dimensions you enter are measured from the corner of the bounding

box selected in this dialog.
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Box Stock >

Stock Geometry

Height iH) |

k‘u Length (L)
X

Cormner Coardinates

><.3|-4.25 |%v.3|-2.5 |%z.:|-n.125 |%

' Dimenzions

[]lgnare Wireframe Geometry in Bounds Computation

| ] | | Cancel | | Help

y Thedimensions of the stock are interpreted in relation to the
corner selected in the dialog box above. For example if the corner
of the box is selected as the Bottom South West corner (as shown in
the dialog above), the Length (L) is interpreted to be along the +X axis,
the Width (W) along the +Y axis and the Height (H) along the +Z axis.

The direction of the dimensions will change depending on the corner
selected. For example if the Top South West corner is selected, then
the Height (H) is interpreted to be along the —Z axis and so the stock
will extend below the corner.

3. Pick OK and notice that the Stock type now appears under Machining Job in the Machining
Browser.
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EIE Machining Job
b Machine - 3 Axis

........ ‘E Setup 1

4. If the stock does not display on the screen, select the Stock Visibility icon located at the
base of the Machining Browser.

@r@ia" & o

Stock Visibility

5 s
% Teggle Stock Visibility tures %E K-Bases

TG o o vl Xy

|:|'|-m Too'

5.3 Align Part and Stock

Once the stock model is created you can move it in alignment with the part if needed.

1. Fromthe Program tab select Align and then Align Stock from the menu to display the
dialog. Notice that we are working our way from left to right in the Program tab.
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Program Simulate

Y

M Machine E‘i Stock - “ Work Zero 2= 4 Axis ~ &
& Post B Align|-| =F 2Axis v (@ 5Axis v G v

i%i Setup T % % - | A ﬁ Holes ~

Machine Setup align

Set
e Stuck[éWDrldC.S -
= i-;_‘ Machin

ning Operations

3 Machine - 3 Ax
25 Post- AbilitySy| Aligh
5

Align Part and/or Stock
Geometry

tock Align

Stock - Box 5t
Fictures - Mone

% Setup 1

2. ForZAlignment select Top and for XY Alignment select Center and then pick OK.

Align Part and/or Stock Geometry

Align Stack about Part

x

£ Alignment

® Top () Center

o dlignment

(O Northwest () Marth

() Midwest (®) Center
() Southwest () South

() Bottom

() Morth E ast
() Mid-E ast
() South E ast

[ ] Ignore ‘wireframe Geometry in Part Bounds Computation

] | | Cancel | | Help
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The stock is now aligned to the Center of the part in XY and the Top of the partin Z.

Stock is Aligned

5.4 About Fixtures - Skip if XPR Configuration

If you are running the STD or higher configuration, you will notice an icon in your Machining Job
named Fixture. For this exercise we are assuming that our stock is fastened to the machining
table using vacuum or double-sided tape. In the future you can model your fixtures and define
them using the steps below.

1. Findthe @ Fixture icon located under the Machining Job tree and double-left-click on it.

= Machining Job
y Machine - 3 Axis
i Post- Haas
f:ﬁ Stock - Nene

CASIR | ictures None
- i%Sf_-tup1

Double-left-click on the Fixture icon to
define afixture

2. You are prompted to select one or more solids to represent your fixture(s). Right-click or
press <Enter>when done. The Create Machining Fixture dialog will display listing your
selected geometry.
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Create Machining Fixture

Fisture D efinitian

Firture Mame: Fisture 1

Fisture Geomety

#  Selected Machining Feature(s]
1 Solidl

25 Bemove Al 2 Femove Active

% Select Solid(z] Fisture Clearance Distance

Save Cancel

0.2

Help

Create Machining Fixture Dialog

29

3. Since we are not using fixtures for this exercise, select the Cancel button to continue.

5.5 Specify Material

Next, we'll set the material for the stock geometry.

1. From the Program tab select Material to display the dialog box.
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MILLII‘m Program Simulate & H 3@
M Machine 6]3 Stock - “ Work Zero 2= 4 Axis ~ &
% Post B nign v 2 2mxis v (@ 5 Axis v &g -
% Setup v ¥ Material Al 3 Axis Adv ~ |—'£-| Holes ~
Machine Setup ck Machining Operations

B4 Machin paerial

I
y ;: Define Stock Material
@ Pq =

@ Fitures - Mone
%

Setup 1

2. For Material, select Wood from the list of available materials and then pick OK.
Select Stock Material pd
Choose Stodk Material
Material File

FeedsSpeedsDatalMCH.xml

Material

WooD ~

Material Texture

Source folder for material files:

sgramDataMecSoft Corporation’y

Cancel Help

3. If the material texture does not display on the stock, select the Material Texture Visibility

icon 'é:’located at the base of the Machining Browser.
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B &
Ly’
Material Texture Visibility

Visual

&;E Toggle Material Texture
Visibility on Stock 3 %ﬁ K-Bases

Wood Texture is
Displayed

5.6 SetWork Coord Sys (Work Zero)

Now that the stock is aligned to the part geometry, in this step, we will establish the work
coordinate origin also referred to as the Work Zero. The Work Zero translates the MCS origin from
the Setup to the desired location. This can be set to any location on the part or stock geometry.

n The Work Zero defines the zero point with respect to which all

toolpath points are interpreted by the controller. This would
normally be the same as the tool touch off point on the actual
work-piece on your machine. So care should be taken to make sure
that this Work Zero point defined in Visual CAD/CAM matches the
tool zero point used on the actual work piece located on the table
of your machine.

1. From the Program Tab select Align and then Set World CS.
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MlLLII‘m Program Simulate o & @

M Machine 6]3 Stock - “ Work Zero 2= 4 Axis ~ &
% Post B3 Aign|-| = 2Axis v (@ 5Axis v &g -

is: Setup T by v |—'£-| Holes ~
Machine Setup align Set Ining Operations
B Stock WorldC.S |« ¢
-4 Machin
3 Machine - 3 Axis % Locate World Coordinate
=z¢ Post - AbilitySyst Sat Systern

Worldc.5 Locate WC5S

@ Fitures - Mone
g Setup 1

2. Then select Set to Stock Box.

3. Thenset Zero Face to Highest Z and Zero Position to South West corner. This sets the
machine home to the top of the stock material and the southwest corner of the stock
geometry.

4,

Pick OK and the part and stock geometry are now transformed to the World Coordinate
Origin (WCS).
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Locate "S5 with respect to Part or Stock |

Setw i
Fick @ SettoStock Box () Setto Part Box

era Face

@ Highest 2 TiMidZ ) Lowest 2

Zero Pogition
Maorth 'West ) Marth (7 Morth East
West (") Center () East

South'West () South (71 South East

x[425 |SHv[2s  [Hzus [y

OF. ][ Cancel ][ Help ]

Alternatively you can use Work Zero to set the work coordinate origin. Instead of moving the part
and stock to the WCS origin, this moves the machine coordinate system origin to the specified

location.

1. From the Program Tab select Work Zero to display the dialog.
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MILL|'TB| Program | Simulate o & @
M Machine 6 Stock - “ Work Zero| 2= 4 Axis ~ &
% Post B mign v 2 24 v (@ 5 Axis v g -
7% Setup = §E Material A 3 AxisAdv v gy Holes -
Machine Setup Stock Machining Operations

&1 Machining Job Work Zero

3 Machine - 3 Axis
f2  Post - AbilitySyste
ﬁ Stock - Box Stock
@ Fixtures - Mone
g Setup 1

Set Current Work
Coordinate Zero

5. Then select Set to Stock Box.

6. Then setZero Face to Highest Zand Zero Position to South West corner. This sets the
machine home to the top of the stock material and the southwest corner of the stock

geometry.
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Set Work Zero

Pick.
era Face
@ Highest 2 TIMidZ (7 Lowest 2

Setto Stock Box () Setto Part Box

Zero Pozition
1 Marth Wwest (0 Marth (70 Marth E ast

West (71 Center i) East
@ Southwest () South (71 South East

s 4,25 %ﬂ-za |%z|n.125 E

[ Ignore wireframe Geometry in Part Bounds Computation

Cutput Wwéork, Offzet

Whork, Offzet Regizter Mumber: %

Generate ] [ Cancel ] [ Save ] [ Help ]

7. Pick Generate and notice that the MCS is translated and that the Work Zero now appears
under Setup 1in the Machining Browser.
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n Note that the Work Zero should appear as the FIRST item UNDER
the Setup in the Machining Job tree so that all operations in that

Setup will inherit that Work Zero origin.

= Machining Job
y Machine - 3 Axis
i Post- Haas
fff] Stock - Box Stock

@ Fixtures - Mone

= E Setup 1

I,
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Create Tools

To machine the above part we will now create a % inch (0.5”) Flat End Mill.

1. Nexttothe Program tab at the top of the Machining Browser, locate and select the Tools
Machining Objects button. Selecting this button toggles the Machining Objects lower
portion of the browser On and Off. Then locate the Tools tab and pick the Create/Edit
Tools icon.

These buttons and icons are shown in the menus below:

First pick the Tools Machining Objects button to make sure the Tools tab is displayed:
Program Simulate & F -8 @

W Mag™ :
%5 Posd J‘ﬂ Tools Machining Objects

e

1 geyy| Tools, Machining Objects
Browser

Machine
=}, Machining Job
3 Machine - 3 Axis
S_;ﬁ Post - Haas
Ei Stock - Box Stock
@ Fixtures - Mone
=l ﬁ Setup 1

> [

achining Operations

Then select the Create/Edit Tools icon:

'f-g Tools C?Reginns JJ Features %ﬁ K-Bases
A

L@ x_
[ Create/Edit Tu:u:-lsl

WWW

2. This will display the Create/Select Tool dialog. Select Flat Mill from the Tool Type menu at
the top of the dialog.

Create/Select Tool }
8(8/8 4>
Tools in ’.
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3. Settool Name to FlatMill-0.5 and Tool Diameter to 0.5. Underthe Properties tab set
Material to HSS and Tool Number to 1.

Create/Select Tool

BB B/ VHYEBLAVYVOZEBVNERPYSY

Toolz in Session

:

Shank
Diameter
Tool
Length
Shoulder
Length
Flute
Length

|

Tool Diameter

Mame  Flathdill-0.5

Shank Dia.  Tool Len, Shoulder Len.
05 =4 = [25 =
Flute Len Tool Dia

258 = 08 =

Holder Default Holder ~ ..

Save as Mew Tool

a
Properties Feeds & Speeds
Material  HSS ~
Cut Material Color l:l &
Murnber of Flutes 2 =
Toal Mumber 1 =
Adjust R egister 1 =
Cutcom Fegister 1 =
Avial Offzet 0 =
Coolant  Mone ~
Comments
Save Edits to Tool Delete Tool
Exit Help

4. Switch to Feeds and Speeds tab and click Load from File.
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| Properties Feeds & Speeds

Spindle Parameters
Speed 3055 = RPk

Direction () Cw () COWw

Feed R ates [in/min)

u Plunge Approach Engage
305 L4875 L4875

| Cut Retract D eparture
|51 x |?E.25 x |91.5 :

Transfer

(® Use Fapid () 5et 122 2

Feed Rate Reduction Factors

-

| Flunge between levels | 100

A First 2 pass o0

A k][] ]| *

i

Boattar & Level

:-|
LI
i

Cut Depth 1] =i

Load from File ..

ave az Mew Tool Save Editz to T ool Delete Tool

5. From the dialog that displays, set Stock Material to Wood and Tool Material to HSS. Check
the other parameters in this dialog and adjust as required for your machine tool.
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Feeds/Speeds

Load Feeds from Table

Drata from T able

Stock b aterial WooD ~
Tool Material HSS ~
Surface Speed 400 = it/min
Feed/Tooth |E “in
Input W ariables
Tool Diameter; E ~in
# of Flutes: E =
b airumn Limitz for Compution
Max Spindle Speed 5000 s RPM
b ax Cut Feed 203 : indmir
Computed W ariables
Spindle Speed 3065 : FIFM
Cut Feed [Cf] B > indmin
Cancel Help

6. Now pick OK and the computed cut feedrate and spindle speed are transferred to the

Feeds and Speeds tab of the Create/Select Tool dialog.
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Create/Select Tool
BB BV YYELLYOEBVNERPIYSY
Tools in Session Properties  Feeds & Speeds

Material  H55 ~

Cut Material Color I:|

T 2 -
Shank Mumber of Flutes =
Diameter Toal Number 1 =
Tool Adjust Register 1 -
Length =
Shoulder Cutcom Register 1 =
Length -
Auial Offzet 0 =

Length Coolant  Mone ~

Comments

Tool Diameter

Mame  Flattill-0.5

Shank Dia.  Tool Len. Shaoulder Len.
0.5 = (4 =| [25 2

Flute Len.  Tool Dia.
25 2 |05 =

Holder Default Holder ...

Save as Mew Tool Save Edits to Tool Delete Tool

Exit Help

7. Pick Save as New Tool to save the tool. The tool is now created and listed under Tools in
Session on the left side of the dialog.

8. Pick OKto close the dialog.

n You can edit the tool properties and pick Save Edits to Tool to
save the changes to this tool. To edit and save this as a New
Tool, you must enter a different tool Name.

The created tool is now listed under the Tools tab in Machining Objects browser.

'rg Tools Gﬂeginns %Features %E K-Bases
'~rm@r O Y ey

4 R

Mo Sort 15, | ¥

FlatMill-0.5 | #1 | Dia:0.5, CRad:0, Taper:0 deg | RPM: 3055 | F: 61

n In the future you can save your tools to a Tool Library. To save
Tools to alibrary, click Save Tool Library under the Tools tab in
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the Machining Objects Browser and specify a folder location and file
name in the Save as dialog box. Two Tool Library file formats are
supported (*.vkb and *.csv). The native Tool Library file format for
VisualCAD/CAM is *.vkb.
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Machine the Inner Profiles

Now we're ready to create our first machining operation.

1. From the Program tab select 2 Axis and then Profiling from the menu of 2 Axis operations.

MILL|'T3|  Program Simulate e G- & @

3 Machine P Stock * o™ WorkZero S 4hxis ~ 3 -
i Post 8 aign - |[=f 2mds|t] @ Saxis v -
Setup = | ¥ Material

L, @ — —l A
Machine Setup Stock ﬁ E ,:l —D—

FaceTop Roughing Facing  Pocketing Pruﬁiing
= Machining Job

3 Machine - 3 Axis v.c:anr T T

i Post-Haas Roughing “-Caring  Engraving Slotting  Chamf

E Profile a curve in 21/2 Axis
= Machining Mode
fjj Stock - None

F‘er:Iiing 2 1/2 Axis Profiling
Fixtures - None : Hole Haole Thread

2 Setup 1 Filleting Focketing  Profiling Milling ~ T-Slotting

y . [7]
Kniife iy

CLiting Sawing  Machining

2% Axis Profiling Menu Item

This will display the 2% Axis Profiling operations dialog. We will go over the steps for
creating the profile operation for the inner features of the Gasket.
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7.1 Control Geometry

2. Underthe Control Geometry tab pick Select Curve/Edge Regions.

2 1/2 Axis Profiling >
Cutlevel:  Entp/Ext  Adwvanced Cut Parameters Comering Parameters Sorting
Control Geometry Tool Feeds & Speeds Clearance Flane Cut Parareters

Part Regions  Awoid Regions  Start Points

#  Selected Machining Regionz)]
1 .f'//— -'"\___ 1
1 \ o — ___// 1
Part
Regions - Avoid
— Region
o / 3
B
£ > w\ ;.fl .
Move Up | W Move Down ~— I

». Remove sl || Femove Active

DE Select Curves/Edge Regions ﬁ

t@ Select Surface Boundary
tg Select Flat Area Regions

Select Pre-Defined Reqions

Cancel Save Help

The Profiling operation dialog is now minimized and allows selection of features to
machine. We will now select the surface edges of the 3inside hole features.

3. Select the first hole by clicking near the upper surface edge as shown below.
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4, repeatto select the edges of the two smaller holes.

Press <Enter> or right-click to end the selection.

5. The 2% Axis Profiling dialog comes back up displaying the selected Part Regions. They are
also highlighted on the part.

6. Notice that selecting a Part Region from the list highlights the corresponding surface edge
curve on the part.
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21/2 Axis Profiling X

CutLevelz:  Entg/Emit  Advanced Cut Farameters  Comenng Parameters Sorting
Control Geometry Tool Feeds & Speeds Clearance Plane Cut Parameters

Part Regions  Awvoid Regions  Start Points

f  Selected Machining Region(z]

DrriveRedqion 1

1
E DriveRegion 2

3 DnveRegion 3

h |

7.2 Cutting Tool

Now we'll select the Tool for our operation:
1. Switch to the Tool tab of the dialog.
2. Select Flat Mill-0.5 under Tools. The 0.5" Flat End Mill is now selected as the active tool.
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2 1/2 Axis Profiling >

CutLevelz  Ent/Emit  Advanced Cut Farameters  Comenng Parameters Sorting
Contral Geometmy Tool Feeds & Speeds Clearance Plane Cut Parameters

= 'Lm Tools H Tool Geometry

H Diameter
Corner Radius

Taper

Lo e T e
[

[

Tip Angle
B Tool Properties

ToolMame F8Aill-0.5

Note that the Tool parameters of the currently active tool are always displayed in the
status bar at the bottom of the Machining Objects Browser.

[} Tools GREQiDHS g Features %ﬁ K-Bases
TGO T ey
Ellfm Tools

T Flathil-0 5

Sort by Name v +‘%* H,F"'

FlatMill-0.5 | #1 | Dia:0.5, CRad:0, Taper:0 deg | RPM: 3055 | F: 61

7.3 Feeds and Speeds

Now we'll set the Speeds and Feeds for our operation:
1. Switch to the Feeds & Speeds tab of the dialog.

2. Selectthe Load from Tool button. Visual CAD/CAM will retrieve the feeds and speeds
parameters that were set when the tool was defined and associate them with the current
operation.
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2 1/2 Axis Profiling >

CutLevelz  Ent/Emit  Advanced Cut Farameters  Comenng Parameters Sorting
Control Geometry Toal Feeds: & Speeds Clearance Flane Cut Parameters

Spindle Parameters
Speed 3055 = FPM ﬂ

Direction (Cn' () Cow

‘\

Cut Start

= Clearance
Plunge: [Ff] 30.5 - in/min |:l|ane

Approach [&f]  |45.75 = ifdrmin /Ef
Engage [Ef] 45.75 = infmin Tt

Feed Rates

Cut [CF] E1 = infmin
Rewact(Rf) (7525 2 in/min bcr
Departure [Df] |31.5 = ifdrmin Df
Transfer [TF] (@) Uze Rapid () Set _E':f_-
122 = inemmin

Feed Rate Reduction Factors Coolant
Plunge bebween levels 100 = Mone v
First = pass a0 =" =4
Bottom 2 Lewvel 100 =

Load fram Toal Load from File ...

t Cancel Save Help

74 Clearance Parameters

Now we'll set the Clearance parameters for our operation:
1. We'll switch to the Clearance Plane tab of the dialog.

2. Setthe Clearance Plane Definition to Automatic and Cut Transfer Method to Clearance
Plane.
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2 1/2 Axis Profiling >

CutLevelz  Ent/Emit  Advanced Cut Farameters  Comenng Parameters Sorting
Control Geometry Toal Feeds & Speeds Clearance Flane Cut Parameters

Clearanize Plane Definition

(®) Automatic «

() Part Max Z + Dist 0.25 =

Clearance Plane

() Stock Max Z + Digt 025

() Abzolute ZWale 025 2 Part Max Z

[] Ignore Wireframe Geometry in Bounds Computation

Cut Transfer Method

Clearance

() Skim
Skim Clearance [C) 0

(®) Clearance Plane «

-

Cancel Save Help

In the Automatic mode, Visual CAD/CAM will determine a safe Z height for locating the
clearance plane. Setting the Cut Transfer Method to Clearance Plane will force all transfer
moves to be performed in this determined clearance plane.

When this tab of the dialog is active, the clearance plane is shown on the graphics screen.
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7.5 Cut Parameters

Now we'll set the Cut Parameters for our operation:
1. Switch to the Cut Parameters tab of the dialog.

2. Setthe Stock to 0. This means that we will not be leaving any thickness on the part after
machining.

3. Under Cut Start Point, uncheck Use Mid-Point of longest side.

4. Underthe Cut Start Side section check the box next to Use Outside/Inside for Closed
Curves and then select Inside.
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2 1/2 Axis Profiling >

CutLevelz  Ent/Emit  Advanced Cut Farameters  Comenng Parameters Sorting
Contral Geometry Tool Feeds & Speeds Clearance Flane Cut Parameters

[3lobal Parameters

Tolerance: -D i} = N
- A Toolpath
stock T é 'L Tolerance

Compensation: |¢“—‘«LITIII£NEINE v| + I+ Stock

Region

Cut Direction
(3 Climb [Down Cut]
() Conventional [Up Cut]

(®) Mixed

Cut Start Paint for Clozed Curves

[ ] Use Mid-Paint of longest side ﬁ ,—f' T

Cutting Side ;
(® Specify () Determine using 30 Mode

(®) Right of Curve () Left of Curves

IJze Outzide/Inzide for Closed Curve
() Outside (@) Inzide

[] sltemate using Nesting

Stepover Control

Total Cut Width D:
StepdCut: D:

[ ] Perform Comer Cleanup

Cancel Save Help

Alternately you could use the Determine using 3D Model option. In this case
VisualCAD/CAM would use the 3D model to determine which side of the curve to place
the cutter for machining.

© Mec Soft Corporation



52 VisualCAD/CAM-MILL 2026 Quick Start

7.6 CutLevel Parameters

Now we'll set the Cut Level parameters for our operation:
1. Selectthe Cut Levels tab of the dialog.
2. Set Location of Cut Geometry to At Top.
3. For Total Cut Depth, enter 0.125. The cut depth is always set as an absolute value.
4

This automatically sets the Rough Depth and Rough Depth/Cut to 0.125.
2 1/2 Axis Profiling >

Control Geometry Tool Feeds & Speeds Clearance Plane Cut Parameters
CutLevels  Entm/Exit  Advanced Cut Parameters  Comering Parameters Sarting

ocation of Cut Geametry
@& Top (At Bottom

. I:I el
() Pick Top = L.\f., Rough Cut Geometry at Top
Depth
Cut Drepth Cantral T ' _E Rough
Total 3 e — Depth/Cut
: | Total Cut Depth: Cut —— 1
. D&pth_'ﬁ_ e Finish
Fough Depth: Finizh D epth: Finizh Depth/Cut

N
Fough Depth/Cut . Finish Depth/Cut: D .
A ]

[]Uze 30 Model to Detect Depth

Cut Levelz Ordering w

{®) Depth First Q_L 5
N 2 <]

i) Lewel First — i

7.7  Entry/Exit Parameters

Next we'll set Entry and Exit parameters for our operation:

1. Select the Entry/Exit tab of the dialog.
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2. Entry/Exit parameters control how the cutter will engage material as it begins cutting and
how it leaves the material as it completes cutting.

3. SetEntry Motions and Exit Motions to None.

4. Now pick Generate.

2 1/2 Axis Profiling >
Contral Geometmy Tool Feeds £ Speeds Clearance Plane Cut Parameters
Cut Level:  Enty/Exit  Advanced Cut Farameters  Comering Parameters Sarting

E nkry b ations
(i Lines & Arcs () Along Path (@) Maone
Linez & Arce
Approach kation
Length (L) :
Mormal Tangent Specify
Angle[a] 0 -
: =
Engage Mation Entry Point on Path
Linear Length (L) 0125
dngle 4] 20

R adial Radius [R) 025

AN EL A A E

1 F

Engage Flamp Height |0

Alang Path 30 Entry
Along Path Angle (&) 10 - Alang Path Height (H) | 0.05 -

E wit Mations
() Lines & Arcz (@) None

i Lines & Arcs
Retract Mation

Linear Length [L] 0.25
Angle (&) 20
R adial Radiuz (R) 0.25

Al k(|4 E]] 2] *

.
Exit Point on Path

-
*

R etract A amp Height

4

Departure Motion
Length [L] |0.25

M armal Tangent Specify
Angle [A] 0 :

[ ] &pply entro/exit at each cut level Owerlap Dist for Clozed Profiles EI =

-

% Cancel Save Help
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5. The 2% Axis Profile toolpath is generated and the operation is listed under Setup 1in the
Machining Browser. NOTE: Notice that it appears UNDER the Work Zero in the Setup.
=k E} Machining Job
e Machine - 3 Axis

7. Note that the display of the toolpath in the graphics screen can be turned on/off by

selecting the ‘£| Toggle Toolpath Visibility icon located at the base of the Machining
Browser.

Wwwh
Bov s E

) Toolpath Visibility 1%

& Toggle Toolpath Visibility

y Toul-s K-Bases

TR
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7.8 Cut Material Simulation

The new toolpath can now be Simulated to display the in-process stock model.

1. Switch to the Simulate tab at the top of the Machining Browser.

2. Select Preferences from the Simulate tab.

MlLLII‘m Program Simulate o i@

£fs] Preferences 6]3 Stock - EI Step Levels ﬂ Stop
" I/\\”‘s O Play [ ToEnd @ Compare
[ Simulate by Moves El Step ml Pause
Options Simulate

Preferences

5 Set Simulation Preferences

@ Fixctures - Mone

=& Setup 1

3. Fromthe Preferences dialog set the following:

Simulation Model: Polygonal Model
Simulation Accuracy: Fine
Remove Remnants During Simulation: Unchecked

55
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Output Contral

Toolpath

Simulation
zer Interface
Post Processor

Lizenzing

Preferences

Geamety Sirnulation Model

Features () Womel O Folygonal () TriDrexel

Stock Sirulation Mode

Cutting Tools 0 Simulate By Moves () Simulate By Distance

Feeds & Speeds

N kin . [ M

Machining b asirnum Dizplay Intereal 100 -

[# of Moves/Distance]: — =

Simulation Accuracy

Standard b edium Fine
Simulation tolerance: 3.029891 30 :

Stack Madel Simulation Display Transparency

Opaque Tranzparent

Remosval OF Remnants

[] Remove Remnants During Simulation

Additional Options
B Stop simulation on erar

[] Dizable advanced OpenGL
Simulation Dizplay State

Drefault e

Reset to defaulks

Cancel Apply Help

CAM Preferences >Simulation

Now pick OK to close the Simulation Preferences dialog.

Pick OK from the message dialog.
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Changing the accuracy of the simulation model! Please rerun
I simulations to see the effects of the change.

6. Then from the Simulate tab, uncheck Simulate by Moves and adjust the slider to the left to
slow down the simulation speed.
MILLII‘m Program Simulate & - & @
@:ﬂ Preferences 6]? Stock T EI Step Lewvels ﬂ Stop
" O Play ¥ ToEnd @ Compare
[ Simulate by Moves m Step ml Pause

Options Simulate

- Machining Job
y Machine - 3 Axis
2 Post-Haas
ﬁ Stock - Box Stock
@ Fitures - Mone
= g Setup 1

‘. Waork fero

[. 2 1/2 Axis Profiling

7. Now, under Setup 1in the Machining Job tree, select the 2% Axis Profiling operation we
just created and then pick Play to start the simulation.

© Mec Soft Corporation



Visual CAD/CAM-MILL 2026 Quick Start

MlLL- Program Simulate ] ﬁ '{:‘E} ﬁ

@ Preferences Ei Stock - gl Step Levels g Stop
" O Pia ¥ ToEnd @ Compare
Simulate by Mowves El 5't4§ ml Pause

Options Simulate
=l Machining Job | p,y

3 Machine -

2 Post-Haa
Stock - Bo
g Fixtures - Mone
= ﬁ Setup 1

‘.' Wark Lero
[l 2 1/2 Axis Profiling

Perform Toolpath
Simulation or Animation

8. You can stop the simulation at anytime by selecting the Pause button from the Simulate
tab. Subsequent to pausing the simulation, you can either choose to continue the

simulation by selecting the Play button again or exit the simulation by selecting the Stop
button.

9. Toview the cut model with textures applied, select the Toggle Material Texture Visibility
icon located at the base of the Machining Browser.
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WM‘W
& Bl Mo P H |t 3 ¥ v(¥)

h Default v

Material Texture Visibility

‘35 Toggle Material Texture
Visibility on Stock
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Machine the Outer Profile

Now we will turn our attention to machining the outer profile of the part. Again, we will create a
simple profile toolpath, this time around the outer perimeter of the part.

1. Switch to Program tab in the Machining Browser.
2. Selectthe 2% Axis Profiling operation we just created.
3. Right-click on the selected operation and select Clone.

=1, Machining Job
‘y Machine - 3 Axis
i Post- Haas
@ Stock - Box Stock
@ Fixtures - Mone
= ‘ti Setup 1
s ‘.' Work Zero

N 2 12 7= Praieg
@ Regenerate

""r K
e Post

Simulate

Simulate Until

Simulate To End

/!\ i
Information

®
MNED

Rename
LI% Suppress
o4 Cut

Copy

Paste

[ [0 )Y

Clone %

Save to Knowledge Base

«

Save As Defaults

i)

Properties
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4. This creates a copy of the operation and places it below the original in the Machining Job.

-4~ Machining Job
y Machine - 3 Axis
{2 Post-Haas
fiﬂ Stock - Box Stock
@ Fixtures - Mone
= E Setup 1
‘. Work Zero
[l 2 1/2 Axis Profiling R (Original)
| ) 21/2 Axis Profiling «—— (Copy)

5. Now right-click on the second operation and pick Edit to adjust its parameters.

= Machining Job
y Machine - 3 Axis
£2%  Post - Haas

Stock - Box Stock

w7
@ Fixtures - Mone

]
o
[ta]
il
=]
m
L
[=1]
a
m

il-i

Post

Simulate

& ¢

Simulate Until

Simulate To End

¥

Y
L1 ]
-

Information

Edit L}

Rename

EARC

Suppress

—
|

6. Fromthe Control Geometry tab, pick Remove All.
7. From the Control Geometry tab, pick Select Curve/Edge Regions.

8. Selectthe top outer surface edge and then right-click or press enter to complete the
selection.

© Mec Soft Corporation



62

Visual CAD/CAM-MILL 2026 Quick Start

21/2 Axis Prefiling

Part Regions  Awoid Regions  Start Paoints

Cutlevel:  Entp/Ext Adwvanced Cut Parameters Comering Parameters Sorting

Control Geometry Taal Feeds & Speeds Clearance Flane Cut Parameters

#  Selected Machining Regionz)]
1 DriveReqion 1

S W A A

x

9. Switch to the Cut Parameters tab and change the Cut Start Side to Outside.
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2 1/2 Axis Profiling >

CutLevelz  Ent/Emit  Advanced Cut Farameters  Comenng Parameters Sorting
Contral Geometry Tool Feeds & Speeds Clearance Flane Cut Parameters

[3lobal Parameters

Region
Talerance: ||0.001 = > T$ ot
oolpa
F “ .'-
Stock: D S __.-'L Tolerance
Compensation: [AUTO/NONE | + I+ Stock
Cut Direction

(3 Climb [Down Cut]
() Conventional [Up Cut]

(®) Mixed

Cut Start Paint for Clozed Curves _ f/

[ ] Use Mid-Paint of longest side -~ Eq_} ?
728

Cutting Side z

(® Specify () Determine using 30 Mode
(®) Right of Curve () Left of Curves

IJze OutzidedInzide for Closed Curve
.@ Outside— 1 lieida
L} For closed regions, select Outside and
[] 2ltemate usi the cut will be made on the outside of
the selected region.

Stepover Contro

Tokal Cut »id

Step/C

Qutside

10. We'll accept all of the remaining parameters and pick Generate.

63

11. The new 2% Axis Profiling toolpath is generated and displayed on the graphics screen.
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12.

Now we'll select the new 2% Axis Profiling operation we just created, select the

Simulation taband then pick Play.
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Post G-Code

Now with the toolpaths complete we're ready to post-process to an output text file containing G-
codes that can then be sent to the machine tool to actually machine the part.

1. Select Setup 1from the Machining Job, right-click and select Post. This will post-process
all operations created under the Setup.

= Machining Job
Machine - 3 Axis
Post - Haas
Stock - Box Stock
Fixtures - Mene
Setup 1
‘I. ‘ﬁ Regenerate

\
g
g

3

.
L]

D ¢

=

-
22 Post

Simulate

2. The Post & Save As dialog is displayed. By default, the Part file name and the Setup name
are appended for the G-code File name. Also by default, the posted G-code file is Saved
in the folder where the part file is located.

y The output file names can be controlled by setting the Posted

File Naming Conventions sections of the Set Post-Processor
Options dialog. Refer to the Select the Post Processor step for
displaying this dialog.
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Post Bt Save As

Save in: Chusck Start

i MName
e

Recent Places

Desktop

=1
Libranes

A

o

Computer

= ™
(1
£l
Metwork
File name:

Save as type;

Current Post:

| Do ol show this dislog again

£x3
- 0@
. Date modified Type
Mo tems match your search.
1 [
MILLGuick Start Tutorial_Setup 1 - [Th]
|Posted Output Files ("nc) ») Cancel
Haas, -

n As you may recall we set the post to Haas back in the Select Post
Processor section of this guide. You can change the post
processor from this dialog by selecting a different one from the drop

down menu in the Current Post list. The posted G-code by default

will be saved to the folder where the part file is located.

3. Now pick Post and the G-code file is displayed in Notepad where it can be viewed or

edited manually.
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Mj MILLCuickStartTuterial_Setup 1.nc - Notepad
File Edit Format View Help

p
08

N1GA48G49G88

(Setup 1)

(Work Zero)

(2 1/2 Axis Profiling)

M2(Tool Diameter = 8.5 Length = 4.8 )

N3G54

NAG28T1IME

N5 S1egeeM3
NEeGI8GEEX1.75Y3.
N7GA378.25H1

M S F29.

4. Now close Notepad.

67
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More about Your G-Code

Once machining operations are created they can be post-processed to a specific machine
controller. To post-process a machining operation, select the operation in the browser, right click
and select Post. The product comes with a set of over 300 post-processors to choose from. The
current post-processor and g-code is also stored with the Part file. The current post-processor and
latest G-Code is stored with the part file for better CAM Life-cycle Management.

[T How your Post-Processor is Stored

When you set the current post-processor for your Machining Job it is saved with your part
file when the file is saved. This keeps the post-processor used to generate your g-code
associated with your part file for better CAM Life-cycle Management.

= Machining Job
y Machine - 3 Axis

:_;,.'i' Post - Haas_with cut_comp-MM_REVS 6

fff] Stock - Box Stock
@ Fixtures - Mone
o-Fid Setup 1
B 2 1/2 Axis Facing
Control Geometry
| FLATMILL- 374 INCH
? Feeds/Speeds

1 Clearance
Parameters

Toolpath
Y G-Code
L_ﬁj In-process Stock
21/2 Axis Pocketing
2 1/2 Axis Pocketing
2 1/2 Axis Profiling

The Current Post-Processor is stored with your Part File

[T] How G-Code is Stored

When you post-process a machining operation from the Machining Job, the G-Code data
is also saved with your part file when the file is saved. This keeps all cam data together
for better CAM Life-cycle Management. If you see that the G-Code icon is flagged, it
means that the latest G-Code has not been captured. Regenerate the operation and the
flag will be removed.
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=1, Machining Job
y Machine - 3 Axis
:_;,.‘i' Post - Haas
fiﬂ Stock - Box Stock

@ Fixtures - Meone
= g Setup 1
=) 21/2 Axis Facing
Control Geometry
[ FLATMILL- 374 INCH
3 Feeds/Speeds
Clearance
é[ Parameters
Toolpath
| B <
I:'@ In-process Stock
| | 21/2 Axis Pocketing

|} 21/2 Axis Pocketing
| | 21/2 Axis Profiling

The G-Code Item within the MOp Folder

[ Editing G-Code from the MILL module

You can view or edit your G-Code from an operation that you have generated by simply
clicking on the G-Code icon within the mop folder.

=1, Machining Job
y Machine - 3 Axis
:_;.‘i' Post - Haas
@ Stock - Box Stock

@ Fixtures - Mone
= 3 Setup 1
= Horizontal Roughing
Control Geometry
W FLATMILL- 172 INCH
3 Feeds/Speeds
Clearance
é[ Parameters
Toolpath
Y G-Code
‘@ In-process Stock
| | Parallel Finishing
| | Radial Machining

G-Code Browser: Tool Crib menu item
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The Machining Browser will be replaced with the Edit tab of the G-Code Editor module.
To return to the MILL module pick the left arrow icon at the top of the G-Code Editor
browser. For documentation on using the G-Code Editor Edit tab click on the "?" help
icon located at the top right side of the G-Code Editor browser.

Edit = o & B
é: Add Line #s " DelLine#s = Cut & Find.. ot Print
AV |nsert Spaces | Y Del Spaces - Copy ¢ Replac L:I Save
“wy Upper Case '3z Lower Case > Paste &) Undo @ Info

i %

2i 00

3 H1G40G435GE80

4 (Horizontal Roughing)

5 HZ(Tool Diameter = 0.5 Length = 5.0 )
i H3G54

Ti H4G20T1Me

i W5 58000M3

@ eEe0m0F N

G-Code Browser: Tool Crib menu item

[T] Example of Posting a Machining Operation.

=l Machining Job

y Machine - 3 Axis

:_;;i' Post - Laguna_HHC

fij Stock - Box Stock

@ Fixtures - Mone

-kl Setup 2
‘. Work Zero

?_1,"2AxisPn-ﬁ Regenerate
21,-‘2AxisPu:n.-1l:‘;; Post
21/2 Axis Pos [s
2172 Axis Poy [ Simulate
Horizontal R

Parallel Finisk

Example of Posting a Machining Operation

Fy

- -

#H-H

Simulate Until

#
e | e e e

=

[T] Post-processing Multiple Machining Operations

You have the ability to select multiple operations or the entire set of machining
operations and post process all of them with a single button click. To do this you need to
select a Setup in the browser, and right click and select Post. This will now post all the

operations that are inside the selected Setup.
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You can also select multiple operations by holding down the Ctrl key.
Example below shows posting multiple machining operations.
=l Machining Job
y Machine - 3 Axis
f Post- Laguna_HHC
f:‘:i Stock - Box Stock

-

21/2 Axis Pock .ﬁ Regenerate

21/2 Axis Pock 1',;? Post

f

= =
P P R
LR G AR G GRS

Harizontal Rou

| | Parallel Finishir (' 3| Simulate
Selecting multiple operations by holdlng down the Ctrl key for posting

f

"Post All" from the Machining Job Folder

Alternatively you can select Machining Job at the root level under the Machining
Browser, right click and select Post All.

=) m Machining Job
y MEChiﬁ Regenerate All

g Post-| o

ﬁ Stock 5.;7 Post Al L}

e Fixturt [T simulate Al

Setup |

‘l We [{u Save to Knowledge Base

—" 21 Q Information

B ?_'I
721 [ Shop Documentation

L
L
|__,|?_'I
L

=

6

- E--F

'?'b Delete All

x|

e ¥

=

| ) Horizontal Roughing (3/8" BEM)
"Post All" from the Machining Job Folder
Post from the Program & Simulate tabs

Post-processing can be done from Program and Simulate tabs under the Machining
Browser.

Selecting Post will display the Post and Save As Dialog.
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The following are the default settings when the Post and Save As Dialog is displayed.

e Post & Save As Dia points to the folder location where the part geometry is
located.

e Save as type —this refers to post file extension. This information is obtained from
the Program tab >Set Post Options dialog.

e Current Post - this refers to the controller/post processor to post process the
toolpath. This information is also obtained from the Program tab > Set Post
Options dialog.

You can override the default settings under the Post & Save As Dialog.

Once you click on the Post button in the dialog, post processing will begin and the posted
file is located under the specified folder.

&8 Post & Save As x
Savein: | 2025 v| @ ? il v
/\ Marme - Date modified Type
WhatsMew-2025 from Joe 1/30/2025 5:23 PM File falder
Lains =] 2% Hole Pocketing Cut Com_Hole Pocketing...  1/30/2025 2:22 PM NC File
‘ I_'|?_x Hole Pocketing Cut Com_Hole Profiling.nc  1/30/2025 2:23 PM NC File
|=| 2x Hole Pocketing Cut Com_Thread Milling.... 1/30/2025 2:26 PM NC File
Desktop J Jx-feedrate-optimization.nc 1/25/2025 %10 PM MC File
|=| 3x-feedrate-optimization-off.nc 1/27/2025 811 AM N File
] |=| 3x-feedrate-optimization-on.nc 1/27/2025 8:29 AM NC File
Libraries ,J AIR FILTER BASE M37_Rigid Tapping CW.nc 1/26/2025 7:08 PM NC File
ij CAMJam #100457_Rigid Tapping CW.nc 1/17/2025 3:38 PM NC File
i |=| Recovered model - XP03-500-060000-REV-A... 2/3/2025 8:38 AM NC File
Th:PC |_'| Rigid-Tapping_Rigid Tapping CW.nc 1/30/2025 3:16 PM MC File
) =l rigid-tap-test.nc 1/17/2025 3:37 PM MNC File
ﬁ [ Toolnath-Ovtimization 2 1 2 Axis Facina.nc 1/30/2025 2:37 PM MC File
Netu_vork
File name: Rigid-Tapping_Rigid Tapping CW nc R | [ Post
Save as type: Posted Output Files (" nc) ~ Cancel

Posted Output Files {* nc)

Current Posk: Pasted Output Files (* tap)

Posted Output Files {*.gc)
Posted Output Files (" cls)
Posted Output Files (" .apt)
Posted Output Files (" txt)
Posted COutput Files {* mpf)
Posted Output Files (" fnc)
Posted Output Files {*iso)
Posted QOutput Files ("NONE)
All Files (".%)

Dialog Box: Post & Save As

[T] Tool Number Validation during Posting

Tool number conflicts are flagged before post-processing multiple operations. If
multiple machining operations use different tools but with one or more coincident tool
numbers, you are notified of this condition with the following message:
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Different tools with the same tool number found in the
operations selected to be posted! Do you want to continue?

Mo
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Generate Reports

11.1 Information Report

At any time, you can create a Report of your Machining Operations.
1. Switch to Program tab in the Machining Browser.
2. Select Setup 1.
3. Right-click and select Information to display and Print the report.

= Machining Job
y Machine - 3 Axis
£z Post - Haas
fﬁ Stock - Box Stock

@ Fixtures - Mone
3=
@ Regenerate

= Post

Simulate
P
k_‘-!-r_) Information I}

Shop Documentation

Machining Operations Information x

Maops Infarmation

Name Status Tool Tool # Cut Feed Spindle Speed #of GOTOs Machining Time
Setup 1

Work Zero Clean No Tool - 0.0

21/2 Axis Profiling  Clean FlatMild.5 1 61.00in/min 3055 RPM 24 0.4 min

2 1/2 Pz Profiling  Clean FlatMild.5 1 61.00in/min 3055 RPM 20 0.39 min

Setuptotal 0.73 min

Frint

Cancel Help

This dialog provides an estimate of the machining time required for the operations in the
Setup.

Note (Professional & Premium configurations only): In the future, if your Machining Job
contains multiple Setups, you can perform the same right-click sequence on the
Machining Job to determine the estimated machining time for all Setups.
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4. Now pick OK to close the Information dialog.

11.2 Shop Documentation

You can also create a Setup Sheet by generating a Shop Document. This is typically used to instruct
machine operators on how to setup and machine the part on the CNC machine.

1. Underthe MachiningJob, select Setup1l.
2. Right-click and select Shop Documentation.

= Machining Job
Machine - 3 Axis
Post - Haas
Stock - Box Stock

Fixtures - Mone

Setugl

o

w
L]

LD ¢

=

“ ‘@ Regenerate

:
:

‘l

Post

Simulate

vl

P
iy
< -

',

o

Information

-

Shop Decumentation I}

Rename

3. Fromthe Save Shop Documentation File dialog, select Templatel and pick Save.
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Save Shop Documentation File [
Savein: |, QuickStad - @ > @
-
i Marme Date modified Type
= MNe items match your search.

Recent Places

Desktop
A
Libraries

A

o oy

Computer

@

]
MNetwork
e -
| Concel |

Saveastype: | Shop Documentation Files (“himi) -
Output Template:  IEmEEl -
| Do not show this dislog again

4. This creates an HTML based Shop Document that can be viewed in a web browser.

You can select from one of the multiple HTML templates that are shipped with the product
and generate shop documentation. Each template provides varying amounts of
information. Once you have selected the Output Template and pick Save, a shop
documentation html file will be created and saved. This file can then be printed and/or
viewed in your default web browser such as Internet Explorer.
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Your CAM Partner

SETUP SHEET

iy W £ PogriGw Maciolt Lo s FansiAN 13 14 kit MR okt ™ o sl _Comsirtet vz
Bt et i | Tonal maihining Fima i1 sms

ek Dimasbais Lol 55500 W1 500 MeghalZh 2435

[eepT— | nchs Mamaa lnn.-.m-.-l Tasal &

PART SETUP

5. Note (Professional & Premium configurations only): In the future, if your Machining Job
contains multiple Setups, you can perform the same right-click sequence on the
Machining Job to generate Shop Documentation for all Setups.
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Where to go for more help

Download this PDF Guide for a list of the available Visual CAD/CAM Resources.

[T] 2026 VisualCAD/CAM Resource Guide

. SO 3% The 2026 VisualCAD/CAM Resource Guide!
VisualCADCAM

) 18 Pages
Resource Guide

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Prefer Printed Documentation? Click Here!

What's New | Quick Start Play List
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https://mecsoft.com/WhatsNew/WhatsNewInVisualCADCAM2026.pdf
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2, Axis Profiling 43
Clearance Plane tab 48
Control Geometry tab 44
Copy/Paste 60
Cut Levels tab 52
Cut Parameters 50
Edit 60
Entry/Exit tab 52
Feeds and Speeds tab 47
Information Report 74
Post G-Code 65

Simulate 55
Tool tab 46
About

the MILL Module 10
the VisualCAM Display 12
This Guide 9
using this Guide 10
Align Part and Stock 26

-C -

Clearance Plane 48
Control Geometry 44
Copy/Paste a Toolpath 60
Create Machining Operations 43
Create Stock Geometry 23
Create Tools 37
Cut Lewels

2, Axis Profiling 52
Cut Parameters

2Y> Axis Profiling 50

-D -

Define the Machine Tool 19

-E -

Entry/Exit
2, Axis Profiling 52

-F -

Fixtures 28

-G -

Generating Reports 74

Getting Ready
Load the Part Model 16
Machining Strategy 18
Main Programming Steps 18

-L -

Load the Part Model 16
Load the Visual CAD/CAM MILL Module 13

Machine
Define 19
Machining Fixtures 28

Machining Setup - Skip if in STD or EXP Configuration
23

Machining Strategy 18

Machining the Outer Perimeter 60
Machining Time 74

Main Programming Steps 18

-P -

Post

Create G-Code 65
Select 20
Profiling 43

-R -

Running Visual CAD/CAM 12
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-S .

Select Cutting Tool 46
Select the Post Processor touse 20
Set Feeds and Speeds 47
Set Work Zero 31
Setup
Machine 23
Setup Sheet 75
Shop Documentation 75
Simulate
2Y> Axis Profiling 55
Specify Material 29
Stock
Align with Part 26
Create Box Stock 23
Specify Material 29

-T-

Tool
Create 37
Useful Tips 9

Using this Guide and Associated Part Files

-W -

What's New 5
Where to go for more help 78
Work Zero 31

10
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